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Introduction to NetBackup
for Domino

This chapter includes the following topics:

■ About the features for NetBackup for Domino

■ About supported Notes database configurations

■ About the Notes database files that can be backed up

About the features for NetBackup for Domino
NetBackup for Domino provides online backups and restores of Notes databases
and individual mailboxes when Domino server has been installed. This capability
is provided as an add-on or extension to the NetBackup client software.

Table 1-1 Features of NetBackup for Domino

DescriptionFeature

Tight integration with NetBackup indicates the following:

■ An administrator already familiar with NetBackup can easily configure backups and restores
Notes databases and transaction log extents.

■ Features and strengths of the NetBackup product suite are also available with NetBackup
for Domino. These features include software data compression, scheduled and
user-directed operations, and multiple data stream backups. Many of these features are
described in detail in the NetBackup Administrator’s Guide, Volume I.

Tight NetBackup
integration

Administrators can define Notes policies, back up and restore Notes databases, and back
up and restore archive-style transaction log extents from a central location.

Central administration
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Table 1-1 Features of NetBackup for Domino (continued)

DescriptionFeature

Notes database backups are saved directly to a wide variety of storage devices that the
NetBackup master server supports.

Media management

Notes databases, mailboxes, and transaction logs can be backed up without taking down
the Domino server. This feature ensures the availability of Notes services and data during
the backup.

Online backups

Administrators can set up schedules for automatic, unattended backups for local or remote
clients across the network. These backups can be full or incremental and are managed
entirely by the NetBackup server from a central location. The administrator also can manually
back up clients.

Automated backups

An administrator that uses the NetBackup client can browse Notes database and mailbox
backups and select the ones to restore.

Restore operations

Backups can be restored a different path.Redirected restores of
databases

NetBackup for Domino takes advantage of the ability of Domino to log transactions against
one or more databases and mailboxes. Transaction logging may be circular style, linear style,
or archive style.

Transaction logging

Transaction logging enables NetBackup for Domino to perform a point-in-time recovery of a
logged databases and mailboxes.

Point in time recovery

Compression increases backup performance over the network and reduces the size of the
backup image that is stored on the disk or tape. This feature is only supported for

Compression of
backups

With checkpoint restart, NetBackup retries a failed backup from the last checkpoint rather
than restart the entire job. With this feature, the NetBackup administrator can also pause a
job and resume it later.

Checkpoint restart for
backup jobs

Administrators can back up databases from a partitioned Domino server.Backups of Domino
Partitioned Server

Administrators can back up databases within multiple Domino installations.(UNIX or Linux)
Backups of multiple
Domino installations

About supported Notes database configurations
NetBackup for Domino supports backups and restores of Domino server and of
local databases.
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The database agent has the ability to log transactions against one or more Notes databases.
If transaction logging is enabled on the server, all logged database transactions go into a
single transaction log. This log consists of one or more files or extents. Where archive-style
transaction logging is used, the archived log files serve as the incremental backup for the
logged databases. Transaction logging must be enabled to recover logged databases.

Logged Domino Server
databases

An unlogged database is one in which transaction logging is not enabled, or has been disabled
for specific server databases.

Unlogged databases are backed up when a full backup is performed. Unlogged databases
are also backed up when an incremental backup is performed and the unlogged database
has been recently updated. The database can be restored only to the point of the latest
database backup.

Unlogged Domino
Server databases

Local databases are the Notes databases that are not located in the Domino data directory,
cannot be shared, and cannot be logged. Local databases are treated similarly to unlogged
Domino server databases when they are backed up and restored.

Local databases

About the Notes database files that can be backed
up

NetBackup for Domino supports the following database types:

■ .NTF Notes template files

■ .NSF Notes server files

■ .BOX Notes mailbox files

For UNIX clients, you can allow Notes databases with other extensions to be backed
up (or limit the default list of extensions). Create the file
/usr/openv/netbackup/lotus.conf. If the lotus.conf file exists, the default
extensions are overridden and only those databases with the extensions listed are
backed up. In the lotus.conf file, enter each extension on a separate line. Enter
only the extension with no leading period or trailing characters.

The Domino server has the ability to log transactions against one or more Notes
databases. All databases are logged by default when the following occurs:

■ The administrator enables transaction logging.

■ The database is in the Domino data directory.

All logged database transactions go into a single transaction log that consists of
one or more files or extents. NetBackup supports all transaction logging styles:
circular, linear, or archive.
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When archive-style logging is used, the log files can serve as the incremental backup
for logged databases. The database agent does not delete the transaction log
extents after backup. The Domino server manages when a transaction log extent
is reused.
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Installing NetBackup for
Domino

This chapter includes the following topics:

■ Planning the installation of NetBackup for Domino

■ NetBackup server and client requirements

■ Notes server software requirements

■ About the license for NetBackup for Domino

■ Specifying the Notes home path (UNIX)

■ (UNIX or Linux) About adding new Notes installations

Planning the installation of NetBackup for Domino
Table 2-1 shows the major installation steps needed to run NetBackup for Domino.
Each step contains one or more links to pertinent procedures and concepts.

Table 2-1 Installation steps for NetBackup for Domino

DescriptionActionStep

Go to the NetBackup compatibility list site.

http://www.netbackup.com/compatibility

Click on the following document:

Application/Database Agent Compatibility List

Verify the operating system and platform
compatibility.

Step 1
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Table 2-1 Installation steps for NetBackup for Domino (continued)

DescriptionActionStep

See “NetBackup server and client requirements” on page 12.

See “Notes server software requirements” on page 13.

Verify the installation prerequisites.Step 2

See “About the license for NetBackup for Domino”
on page 13.

Add the license key for NetBackup for
Domino.

Step 3

See “Specifying the Notes home path (UNIX)” on page 13.(UNIX or Linux) Specify the Notes home
path.

Step 4

NetBackup server and client requirements
Verify that the following requirements are met for the NetBackup server:

■ The NetBackup server software is installed and operational on the NetBackup
server.
See the NetBackup Installation Guide.

■ Make sure that you configure any backup media that the storage unit uses. The
number of media volumes that are required depends on several things:

■ The devices that are used and storage capacity of the media

■ The sizes of the databases that you want to back up

■ The amount of data that you want to archive

■ The size of your backups

■ The frequency of backups or archives

■ The length of retention of the backup images
See the NetBackup Administrator’s Guide, Volume I.

Verify that the following requirements are met for the NetBackup clients:

■ The NetBackup client software is installed on the computer that has the
databases you want to back up.

■ To use the new features that are included in NetBackup for Domino in NetBackup
10.0, you must upgrade your NetBackup for Domino clients to NetBackup 10.0.
The NetBackup media server must use the same version as the NetBackup for
Domino client or a higher version than the client.
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Notes server software requirements
Verify the following regarding the Notes server software on the NetBackup server
or client:

■ Notes server software must be installed and operational.
Partition servers are supported. More than one Notes installation is supported
on UNIX.

About the license for NetBackup for Domino
The NetBackup for Domino agent is installed with the NetBackup client software.
No separate installation is required. A valid license for the agent must exist on the
master server.

More information is available on how to add licenses.

See the NetBackup Administrator’s Guide, Volume I.

Specifying the Notes home path (UNIX)
After you install NetBackup with a valid license for NetBackup for Domino, run this
script on the computer where the Notes vendor software is installed. With this script,
NetBackup can gather additional information about your Notes environment.

To specify the Notes home path

1 Change to the following directory:

/usr/openv/netbackup/bin

2 Run the following script:

./lotusnotes_config

3 Supply the home path for the database installation.

For example:

/opt/lotus

4 Add any other database installations, or enter n if you are finished.
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(UNIX or Linux) About adding new Notes
installations

If you install a new Notes installation after you install NetBackup, you need to add
this new installation to the NetBackup configuration. This action ensures that all
new Notes installations are included in backup operations.
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Configuring NetBackup for
Domino

This chapter includes the following topics:

■ About configuring NetBackup for Domino

■ Configuring Notes fast restores

■ Configuring host properties for a Notes client

■ About configuring a backup policy for a Notes database

■ Configuring a backup policy for Notes database supporting files

■ Performing a manual backup

About configuring NetBackup for Domino
Complete the procedures in Table 3-1 to configure your environment.

Table 3-1 Steps to configure NetBackup for Domino

DescriptionActionStep

See “Configuring Notes fast restores”
on page 16.

Configure Domino fast restores.Step 1

See “Configuring host properties for a
Notes client” on page 17.

Configure the host properties for the
Notes clients.

Step 2

See “About configuring a backup policy
for a Notes database” on page 19.

Configure a backup policy.Step 3
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Table 3-1 Steps to configure NetBackup for Domino (continued)

DescriptionActionStep

See “Configuring a backup policy for
Notes database supporting files”
on page 30.

Configure a backup policy for database
supporting files.

Step 4

See “Performing a manual backup”
on page 31.

Test the configuration settings.Step 5

Configuring Notes fast restores
During Domino restores, the NetBackup for Domino agent automatically restores
any reused transaction logs that are required for recovery. Typically one transaction
log extent is restored at a time and recovery is completed for the transactions in
that log. Because the restore of the log and application of transactions is a sequential
process, the restore and recovery performance is slow. NetBackup prefetches the
required transaction logs before recovery. Then multiple transaction logs can be
restored at a time and made available for recovery.

Review the following recommendations:

■ Sufficient disk space must be available for the specified number of logs in the
transaction log cache location.

■ The transaction log cache directory and the Domino transaction log directory
should be on the same file system. This configuration ensures that the transaction
logs are “moved” to the Domino transaction log directory at the time of recovery
rather than being “copied.” (Copying is time consuming.)

■ You should create the cache directory before you start a restore job.

To configure Domino fast restores

1 Configure the transaction log cache path.

This location is where NetBackup temporarily stores the prefetched transaction
logs.

See “About the transaction log cache path” on page 17.

2 Configure the maximum number of logs to restore.

This setting determines how many transaction logs are restored in a single
restore job during recovery.

See “About the maximum number of logs to restore” on page 17.

16Configuring NetBackup for Domino
Configuring Notes fast restores



About the transaction log cache path
NetBackup restores the prefetched transaction logs to the directory that is specified
by this parameter.

See “Configuring host properties for a Notes client” on page 17.

Note the following when you configure the transaction log cache directory:

■ Create the cache directory before you start a restore job. If the specified path
does not exist it is created during restore.

■ The user must have write permission for the folder or the restore job fails with
a Status 5 error.

■ If a path is not specified, transaction logs are restored to the original location,
the Domino transaction log directory.

■ If the value of Maximum number of logs to restore is less than or equal to 1,
this path is ignored. The logs are not prefetched; one transaction log extent per
job is restored to the Domino server’s log directory.

■ If there is not sufficient space to restore the specified number of logs, NetBackup
tries to restore only the number of logs that can be accommodated. This
calculation is done only if the cache directory is present before the restore job
is started.
See “About the maximum number of logs to restore” on page 17.

About the maximum number of logs to restore
This value specifies the maximum number of transaction logs restored in a single
restore job during recovery.

See “Configuring host properties for a Notes client” on page 17.

Note the following when you configure the maximum logs to restore:

■ If negative value or 0 is specified or if the value is not specified, then the default
value of 1 is used.

■ If the value is greater than 1 the transaction logs are prefetched only. If the value
is less than 1, one transaction log extent per job is restored to the Domino
server’s log directory.

Configuring host properties for a Notes client
The following instructions describe how to define the properties for a Notes client
using the NetBackup Administration Console.
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To define properties for a Notes client

1 Open the NetBackup Administration Console.

2 Expand NetBackup Management > Host Properties > Clients.

3 In the right pane, right-click the client name and select Properties.

4 In the left pane, expandWindows Client or UNIX client and select Lotus
Notes.

5 In the Client Properties dialog box, provide the necessary information.

See “Lotus Notes properties” on page 18.

6 Click OK to save your changes.

Lotus Notes properties
The Lotus Notes properties apply to the clients that are currently selected and that
run NetBackup for Domino.

For UNIX servers: If you have multiple installations of Domino server, the values
in the client properties only apply to one installation. For other installations, specify
the installation path and location of the notes.ini file with the LOTUS_INSTALL_PATH
and NOTES_INI_PATH directives in the backup policy.

Table 3-2 Lotus Notes client host properties

DescriptionClient host
properties

The maximum number of logs that can be prefetched in a single restore job during recovery.
Specify a value greater than 1.

A value less than or equal to 1, does not gather transaction logs during recovery. One
transaction log extent per job is restored to the Domino server’s log directory.

LOTUS_NOTES_LOGCACHESIZE = 3

Maximum number of
logs to restore
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Table 3-2 Lotus Notes client host properties (continued)

DescriptionClient host
properties

A path where NetBackup can temporarily store the prefetched transaction logs during recovery.
If you do not specify a path, during recovery NetBackup restores the logs to the Domino
server's transaction log directory.

Note the following:

■ If the specified path does not exist then it is created during restore.
■ The user must have write permission for the folder.
■ Transaction logs are restored to the original location, the Domino transaction log directory,

if a path is not specified.
■ If the value of Maximum number of logs to restore is less than or equal to 1 then this

path is ignored. The logs are not prefetched; one transaction log per job is restored to the
Domino Server’s log directory.

■ If there is not sufficient space to restore the specified number of logs, NetBackup tries to
restore only the number of logs that can be accommodated.

Transaction log
cache path

The notes.ini file that is associated with the Domino partitioned servers used to back up and
restore the Notes database. This setting does not apply to non-partitioned servers.

■ On Windows:
If the notes.ini file is not located in the default directory, indicate its location.

■ On UNIX:
If the notes.ini is not located in the directory that is specified in the Path, indicate its
location here.
Include the directory and the notes.ini file name.

INI path

The path where the Notes program files reside on the client. NetBackup must know where
these files are to perform backup and restore operations.

■ On Windows:
The path for program directory (where nserver.exe resides).

■ On UNIX:
A path that includes the Domino data directory, the Notes program directory, and the
Notes resource directory.

Path

About configuring a backup policy for a Notes
database

A backup policy for a database defines the backup criteria for a specific group of
one or more clients.

These criteria include the following:
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■ Storage unit and media to use

■ Policy attributes

■ Backup schedules

■ Clients to be backed up

■ Items to be backed up, including a list of databases and directives

To back up the database environment, define at least one Lotus-Notes policy with
the appropriate schedules. A configuration can have a single policy that includes
all clients, or there can be many policies, some of which include only one client.

If you have both UNIX and Windows clients, create at least two policies: one
exclusively for UNIX clients and another exclusively for Windows clients. In addition
to the Lotus-Notes policy, configure a Standard or MS-Windows policy to back up
database supporting files.

See “Configuring a backup policy for Notes database supporting files” on page 30.

Most requirements for database policies are the same as for file system backups.
In addition to the policy attributes for this database agent, other attributes are
available that you should consider.

See the NetBackup Administrator’s Guide, Volume I.

Adding a NetBackup for Domino policy
This topic describes how to add a new backup policy for a database.

To create a policy to backup database supporting files, you need to perform a
different procedure.

See “Configuring a backup policy for Notes database supporting files” on page 30.

To add a new NetBackup for Domino policy

1 Log on to the master server as administrator (Windows) or root (UNIX).

2 Start the NetBackup Administration Console.

If your site has more than one master server, choose the one on which you
want to add the policy.

3 Select NetBackup Management > Policies. Then select Actions > New >
Policy.

4 Type a unique name for the new policy and click OK.

5 From the Policy type list, select Lotus-Notes.

The Lotus-Notes policy type does not appear in the drop-down list unless your
master server has a license for the database agent.

20Configuring NetBackup for Domino
About configuring a backup policy for a Notes database

http://www.veritas.com/docs/DOC5332


6 Complete the entries on the Attributes tab.

See “About policy attributes” on page 21.

7 Add other policy information as follows:

■ Add schedules.
See “Adding schedules to a NetBackup for Domino policy” on page 22.

■ Add clients.
See “Adding clients to a policy” on page 25.

■ Add database objects to the backup selections list.
See “Adding backup selections to a Notes policy” on page 26.

8 When you have added all the schedules, clients, and backup selections you
need, click OK.

About policy attributes
With a few exceptions, NetBackup manages the policy attributes set for a database
backup like a file system backup. Other policy attributes vary according to your
specific backup strategy and system configuration.

For more information on policy attributes, see the NetBackup Administrator’s Guide,
Volume I.

Table 3-3 Policy attribute for NetBackup for Domino policies

DescriptionAttribute

Determines the types of clients that can be backed up with the policy. For Notes databases,
select the policy type Lotus-Notes.

Policy type

Enable this feature to have NetBackup take checkpoints during the backup jobs for the policy.

The checkpoint frequency indicates how often NetBackup takes a checkpoint during a backup.
The default is 15 minutes. The Schedule backup attempts global attribute indicates the
number of times that NetBackup attempts a failed backup.

See the NetBackup Administrator’s Guide, Volume I for more information on these options.

Take checkpoints
every

Enables the compression of backups. This option is only supported for NetBackup for Domino
clients for Windows. A Domino client on UNIX cannot perform compression. If you want to
use compression and have both Windows and UNIX clients, create two backup policies. Use
one policy for Windows clients and one policy for UNIX clients.

For more information on advantages and disadvantages of compression, see the NetBackup
Administrator’s Guide, Volume I.

Compress

21Configuring NetBackup for Domino
About configuring a backup policy for a Notes database

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


Table 3-3 Policy attribute for NetBackup for Domino policies (continued)

DescriptionAttribute

Specifies that NetBackup can divide automatic backups for each client into multiple jobs.
Each job backs up only a part of the list of backup selections. The jobs are in separate data
streams and can occur concurrently. The number of available storage units, multiplex settings,
and the maximum jobs parameters determine the total number of streams and how many
can run concurrently. Not all directives in the backup selections list allow for multiple database
streams.

Allow multiple data
streams

A textual description of a backup. Useful for browsing backups and restores.Keyword phrase

Adding schedules to a NetBackup for Domino policy
Each policy has its own set of schedules. These schedules control the initiation of
automatic backups and also specify when user operations can be initiated.

To add a schedule to a NetBackup for Domino policy

1 In the Policy dialog box, click the Schedules tab.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

2 Click New.

3 Specify a unique name for the schedule.

4 Select the Type of backup.

See “NetBackup for Domino backup types” on page 23.

5 Specify the other properties for the schedule.

See “About schedule properties ” on page 22.

6 Click OK.

About schedule properties
This topic describes the schedule properties that have a different meaning for
database backups than for file system backups. Other schedule properties vary
according to your specific backup strategy and system configuration. Additional
information about other schedule properties is available. See the NetBackup
Administrator’s Guide, Volume I.

22Configuring NetBackup for Domino
About configuring a backup policy for a Notes database

http://www.veritas.com/docs/DOC5332
http://www.veritas.com/docs/DOC5332


Table 3-4 Description of schedule properties

DescriptionProperty

Specifies the type of backup that this schedule can control. The selection list shows only
the backup types that apply to the policy you want to configure.

See “NetBackup for Domino backup types” on page 23.

Type of backup

You can schedule an automatic backup in one of the following ways:

■ Frequency
Frequency specifies the period of time that can elapse until the next backup operation
begins on this schedule. For example, assume that the frequency is 7 days and a
successful backup occurs on Wednesday. The next full backup does not occur until the
following Wednesday. Typically, incremental backups have a shorter frequency than full
backups.

■ Calendar
TheCalendar option lets you schedule the backup operations that are based on specific
dates, recurring week days, or recurring days of the month.

Schedule type

Specifies a retention period to keep backup copies of files before they are deleted. The
retention level also denotes a schedules priority within the policy. A higher level has a higher
priority. Set the time period to retain at least two full backups of your database. In this way,
if one full backup is lost, you have another full backup to restore. For example, if your
database is backed up once every Sunday morning, you should select a retention period
of at least 2 weeks.

Retention

NetBackup for Domino backup types
In a policy’s schedule you define the type of backups you want to perform.

See “Adding schedules to a NetBackup for Domino policy” on page 22.

Table 3-5 Description of NetBackup for Domino backup types

DescriptionType of backup

Backs up all the Notes databases that are identified in the backup selections list. Available
transaction logs extents are also backed up if the BACKUP_TRANSACTION_LOGS directive
is specified in the list. The inactive transaction log extents are marked as ready to reuse after
they are successfully backed up. The Domino server handles the actual recycling of transaction
log extents.

Full backup

23Configuring NetBackup for Domino
About configuring a backup policy for a Notes database



Table 3-5 Description of NetBackup for Domino backup types (continued)

DescriptionType of backup

The type of database affects the backup, as follows:

■ Unlogged databases or local databases
Backs up all unlogged databases or local databases that were modified since the last full
or incremental backup. The last modification date, not the time stamp or date stamp of
the database file, determines the time the database was last modified.

■ Logged databases (archival-style logging enabled)
Backs up only those logged databases that were assigned a new DBIID since the last full
or incremental backup.

■ Logged databases (circular-style and linear-style logging enabled)
Backs up all logged databases that were modified or assigned a new DBIID since the last
full or incremental backup. The last modification date, not the time stamp or date stamp
of the database file, determines the time the database was last modified.

■ Transaction logs
Backs up all transaction log extents that are identified as available for backup by the
Domino server. The inactive transaction log extents are marked as ready to reuse when
the backup completes successfully.

Differential Incremental
backup

The type of database affects the backup, as follows. Note that the last modification date, not
the time stamp or date stamp of the database file, determines the time the database was last
modified.

■ Unlogged databases or local databases
Backs up all unlogged databases or local databases that were modified since the last full
backup.

■ Logged databases (archival-style logging enabled)
Backs up only those logged databases that were assigned a new DBIID since the last full
backup.

■ Logged databases (circular-style and linear-style logging enabled)
Backs up all logged databases that were modified or have been assigned a new DBIID
since the last full backup.

■ Transaction logs
Backs up all transaction log extents that are identified as available for backup by the
Domino server. The transaction log extents are not marked as ready to reuse when the
backup is completed.

Cumulative Incremental
backup

24Configuring NetBackup for Domino
About configuring a backup policy for a Notes database



Table 3-5 Description of NetBackup for Domino backup types (continued)

DescriptionType of backup

A user backup is similar to a snapshot of the databases at a given point in time. Transaction
log extents are not marked as ready to be recycled after they are successfully backed up.
The content of ongoing full and incremental backups is not impacted.

A user backup is not automatically scheduled and must be initiated on the target client
machine.

You may also want to create a separate policy for user backup schedules. This way you can
easily separate user-directed and scheduled backups.

User backup

Adding clients to a policy
The clients list contains a list of the clients that are backed up during an automatic
backup. A NetBackup client must be in at least one policy but can be in more than
one.

If you want to back up multiple clients, the Domino server install path and the
notes.ini location must be identical for each client. If not, the clients must be
backed up through separate policies.

NetBackup attempts to run each script in the backup selections list for each client
in the client list. If a script is not valid on a particular client, the script is skipped.
(For example, if the Oracle home that is specified in the script does not exist on
that client.) A policy can contain multiple clients and multiple scripts. Only a subset
of the scripts needs to be valid on each client. If the valid scripts are successful,
the entire backup is successful.

For a NetBackup for Domino policy, clients you want to add must have the following
items installed or available:

■ The Domino server or Notes client

■ NetBackup client or server

■ The backup or restore scripts

■ The backup shell scripts

To add clients to a policy

1 Open the policy you want to edit or create a new policy.

To access the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

2 Click the Clients tab and click New.
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3 Type the name of the client and select the hardware and operating system of
the client.

4 Choose one of the following:

■ To add another client, click Add.

■ If this client is the last client you want to add, click OK.

5 In the Policy dialog box, click OK.

Adding backup selections to a Notes policy
The backup selections list names the databases and directives that NetBackup
includes in automatic backups of the clients that are included in the policy.
NetBackup uses the same backup selection list for all clients that are backed up
by the policy.

You should back up the following files:

■ All files in the Domino data directory

■ Any databases that reside outside of the Domino data directory

■ All .ID files

■ All notes.ini files

To create a list of items to back up, perform the following procedures:

■ See “Adding directives to the backup selections list” on page 27.

■ See “Adding Notes databases to the backup selections list” on page 28.

The agent only backs up the databases and directives in the backup selections
lists. To exclude databases from a backup, place them outside the Domino data
directory.

See “About excluding Notes databases from backups” on page 29.

To back up database links and directory links correctly, you must include the local
and the linked directory in the backup selections list.

See “About backups of Notes database links and directory links” on page 30.

Backups of Windows network shared folders and UNIX
NFS directories
NetBackupcan back upWindows network shared folders and UNIX NFS directories.
This capability is useful when Notes databases reside on network storage such as
NAS filers. See the NetBackup Administrator’s Guide, Volume I for detailed
instructions on how to back up network drives and the Follow NFS policy attribute.
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Adding directives to the backup selections list
The following procedure describes how to add directives to the backup selections
list.

To add directives to the Domino backup selections list

1 In the Policy dialog box, click the Backup Selections tab.

To open the Policy dialog box, double-click the policy name in the Policies list
in the NetBackup Administration Console.

2 Click New.

3 Add the directives you want to the backup selections list.

See “About directives for Notes policies” on page 27.

■ Click the arrow button to the right of the Pathname or directive box and
select a directive.

■ Click Add > OK > OK.

Any pathnames or directives you specified are appended to the Backup
Selections list.

About directives for Notes policies
You can add directives to the backup selections list to indicate database objects
you want to back up. More information is available on backup selections.

Table 3-6 Notes directives in the backup selections list

DescriptionDirective

Note: This directive is supported only on UNIX clients.

Performs the backup on all Notes databases on each of the selected
clients. ALL_LOTUS_DATABASESmeans both local databases and Domino
server databases.

Note: Using the ALL_LOTUS_DATABASES directive can have tremendous
performance issues on clients with large or multiple local drives. In this
case, specify more specific directories or databases in the backup
selections list. For example, specify the Domino data directory.

ALL_LOTUS_DATABASES

Backs up all transaction log extents that Domino server identifies as
available for backup.

BACKUP_TRANSACTION_LOGS
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Table 3-6 Notes directives in the backup selections list (continued)

DescriptionDirective

Defines a new stream of data.

A stream can be any one of the following:

■ A single stream for a particular partition of a partitioned Domino server
■ Multiple streams for a single partition on a non-partitioned Domino

server
■ (UNIX or Linux) A single stream for a particular installation of Domino

server installed on a client

The Allowmultiple data streams attribute must be enabled for the policy
on the Attributes tab.

To backup more than one partition from a single policy, you must back up
each Domino partition with a separate data stream. Use the NEW_STREAM
directive and the NOTES_INI_PATH= directive for each data stream.

(UNIX or Linux) To schedule a backup of multiple installations of Domino
server on the same host, backup each Domino server with a separate data
stream. Use the NEW_STREAM directive and the NOTES_INI_PATH and
LOTUS_INSTALL_PATH directives for each data stream.

NEW_STREAM

Identifies the location of the notes.ini file that is associated with the
particular server partition that is used to perform the backup.

To backup a partitioned Domino server, use this directive to indicate the
absolute path for the notes.ini file. This file should be associated with
the server partition you want to use. The server partition that is specified
has an effect on how a database is backed up (logged or unlogged). It
also affects which set of transaction log extents is backed up.

(UNIX or Linux) To configure a backup for one of the multiple installations
of Domino server, use this directive to indicate the absolute path for the
notes.ini file. This notes.ini file should be associated with the server
installation to be used.

NOTES_INI_PATH=

Identifies the location of Notes program files that are associated with a
particular installation of Domino server.

(UNIX or Linux) For one of the multiple installations of Domino server,
indicate the absolute path where the Notes program files are installed.

LOTUS_INSTALL_PATH=

Adding Notes databases to the backup selections list
The following procedure describes how to add databases to the backup selections
list.
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To add Notes databases to the backup selections list

1 In the Policy dialog box, click the Backup Selections tab.

To open the Policy dialog box, double-click the policy name in the Policies
list in the NetBackup Administration Console.

2 Click New.

3 Indicate the database or directory to back up.

■ In the Pathname or directive box, type the full path name of a database
or directory.
You can indicate an NFS pathname or a UNC pathname in the Backup
Selections list. For example,
/export/home/lotus/data (NFS pathname)
\\hostname\share\lotus\data (UNC pathname)
For linked databases and directories, include the pathname to the source
databases or directory.

■ Click Add.

■ Continue to add any other databases and directories to the list.

■ When you have added all the databases or directories, click OK > OK.

About excluding Notes databases from backups
You can exclude specific Notes databases from the backup by using database links
and directory links. This method works if the databases to which the links point are
located outside of the Domino data directory.

Identify the databases you want to exclude and move them to a directory outside
the Domino data path. Then, create a Domino database or a directory link to the
databases. The agent only backs up files with extensions .nsf, .ntf and .box,
and does not follow database links or directory links.

To exclude database files from a backup of a Windows client

1 Open the NetBackup Administration Console.

2 Expand NetBackup Management > Host Properties > Clients.

3 In the right pane, select each of the database clients.

4 Right-click and select Properties.

5 ExpandWindows Client and click Exclude Lists.
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6 For the policy you created to back up the database supporting files, add the
following file types to the list: .nsf, .ntf, .box, .TXN.

7 Click OK.

To exclude database files from a backup of a UNIX client

1 On each database client, create the following file:

/usr/openv/netbackup/exclude_list

2 In the exclude_list file, add the following file types to the list: .nsf, .ntf, .box,
.TXN.

About backups of Notes database links and directory links
The agent only backs up database files with *.nsf, *.ntf, and *.box extensions
in the directories that are specified in the backup selections list of the policy. The
agent does not automatically follow database links or directory links to the actual
databases.

To correctly back up linked databases or linked directories outside of the Domino
data directory, in the backup selections list add the following:

■ The directory containing the Notes databases

■ The directory containing the database link (.nsf file)
OR
The directory containing the directory link (.dir file)

Configuring a backup policy for Notes database
supporting files

To properly back up a database environment, you must back up not only database
files but also the database supporting files. Back up all local drives but exclude the
database and the transaction logs from the backup.

To configure a Domino backup policy for database supporting files

1 Log on to the master server as administrator (Windows) or root (UNIX).

2 Open the NetBackup Administration Console.

If your site has more than one master server, select the one on which you want
to add the policy.

3 In the left pane, right-click Policies and select New Policy.

4 Type a unique name for the new policy.
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5 Click OK.

6 Click the Attributes tab.

7 For the Policy type, select MS-Windows (Windows) or Standard (UNIX).

8 Select other attributes you want.

9 Click the Schedules tab and configure the schedules for this policy.

10 Click the Clients tab and add the clients that you want to back up with this
policy.

11 On the Backup Selections tab, click New.

12 Add the ALL_LOCAL_DRIVES directive to the backup selections list.

■ In the Add Backup Selection dialog box, from the Pathname or directive
list, select ALL_LOCAL_DRIVES.

■ Click Add > OK > OK.

13 Continue with the instructions for excluding database files from the backup of
a Windows client or a UNIX client.

See “About excluding Notes databases from backups” on page 29.

Performing a manual backup
After you configure the servers and clients in your environment, you can test the
configuration settings with a manual backup. Perform amanual backup (or backups)
with the automatic backup schedules you created.

To perform a manual backup

1 In the left pane, click Policies.

2 In the All Policies pane, select the policy you want to test.

3 Select Actions > Manual Backup.

4 Select the schedule that you want to use for the manual backup.
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Performing backups and
restore of Notes
databases

This chapter includes the following topics:

■ Performing a user-directed backup of a Notes database

■ Restoring a Notes database

■ Redirecting a Notes restore to a different client

■ Recovering the Notes environment

Performing a user-directed backup of a Notes
database

A user backup is initiated by the user on the client computer and is not automatically
scheduled. Transaction log extents are not marked as ready to re-use after a backup,
making the backup similar to a snapshot. User backups do not affect the scheduled
full and incremental backups.

Note: Because a user-directed backup does not mark transaction logs as ready to
reuse, it should not replace regularly scheduled full backups or incremental backups.

To perform a user-directed backup of a Notes database

1 Open the Backup, Archive, and Restore interface.

2 (Windows) Select File > Select Files and Folders to Back Up.
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3 (UNIX or Linux) Click the Backup Files tab.

4 Specify what you want to back up, as follows:

■ Expand the Lotus Notes object and select the databases or mailboxes you
want to back up.

■ To back up all transaction log extents, select the Transaction Logs object.

5 Select Actions > Backup.

6 To back up a Domino partition server or one of multiple Domino installations,
specify the notes.ini file that is associated with the partition server or the
installation.

The partition you specify affects how a database is backed up (if logged). It
also affects which set of transaction logs are backed up.

On the Windows interface, this option is available on the Lotus Notes tab.

7 Click Start Backup.

Options for Notes database backups
The following options are available for backup operations of Notes databases.

Table 4-1 General Options tab

DescriptionOption

On the Windows interface, this option is available on Lotus
Notes tab.

To back up a partitioned Domino server or one of several
Domino installations (UNIX/Linux), specify the absolute path
for the notes.ini file. This notes.ini file is associated with
the particular server partition or installation that you want to
use to perform the backup.

The partition you specify affects how a database is backed up
(if logged). It also affects which set of transaction logs are
backed up.

Specify the absolute path
for the notes.ini file that
is associated with the
server instance to use.

Specifies a keyword phrase, up to 128 characters in length,
that NetBackup can associate with the image created by this
backup operation. You then can restore the image by specifying
the keyword phrase in the Search Backups dialog box.

All printable characters are permitted including space (“ ”) and
period (“.”). The default keyword phrase is the null (empty)
string

Keyword phrase to
associate with this
backup or archive
(optional)
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Restoring a Notes database
Note the following when you restore Notes databases.

■ Restore Notes databases from different partitions in separate restore operations.

■ (UNIX or Linux) Restore different installations of Domino server in separate
restore jobs.

■ Warning: Select only the source databases or directory for restore and not the
database links or directory links. If you attempt to restore the links, the actual
database is deleted. This situation can lead to data loss if the database has not
been backed up.
See “Restoring linked databases or directories and manually recreating the link
file” on page 39.
See “Restoring linked databases or directories and the link file” on page 38.

About restoring individual Notes documents or mail
messages
To restore individual documents or mail messages, restore the entire database
under a temporary name on the production server or an alternate server. Once the
restore completes, you can copy individual documents or mail messages from the
temporary database into the actual database with the Notes client.

Restore a Notes database (Windows)
To restore a Notes database (Windows)

1 On the NetBackup client, open the Backup, Archive, and Restore interface.

2 Select File > Select Files and Folders to Restore > from Normal Backup.

3 Select File > Specify NetBackup Machines and Policy Type.

4 Provide the following information:

The server you want to perform the operation.Server to use for backups
and restores

The client on which the backup was performed.Source client for restores

Lotus-Notes.Policy type for restores

5 Click OK.
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6 Select the database or mailbox you want to restore.

Generally, you should not select transaction log extents for a restore. If a
transaction log extent is required to recover a database, it is restored
automatically as part of the database recovery. It is recycled automatically by
the Domino server when the transaction log extent is no longer required.

7 Select Actions > Restore.

8 Choose the destination and other restore options and click Start Restore.

See “General tab” on page 36.

See “Lotus Notes tab” on page 37.

Restore a Notes database (UNIX/Linux)
To restore a Notes database (UNIX/Linux

1 On the NetBackup client, open the Backup, Archive, and Restore interface.

2 Log on as Domino server administrative user.

3 Click the Restore Files tab.

4 Select Actions > Specify NetBackup Machines and Policy Type.

5 Provide the following information:

The server you want to perform the operation.Server to use for backups
and restores

The client on which the backup was performed.Source client for restores

Lotus-Notes.Policy type for restores

6 Click OK.

7 Select the following.

View > Show Most Recent Backup.

View > Refresh.

8 Select the database or mailbox you want to restore.

Generally, you should not select transaction log extents for a restore. If a
transaction log extent is required to recover a database, it is restored
automatically as part of the database recovery. It is recycled automatically by
the Domino server when the transaction log extent is no longer required.
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9 Select Actions > Restore.

10 Choose the destination and other restore options and click Start Restore.

See “General tab” on page 36.

See “Lotus Notes tab” on page 37.

General tab
On this tab you can specify a different location to direct the restore to. By default,
everything is restored to its original directory.

Table 4-2 Restore options on the General tab

DescriptionOption

Restores the selected items to the location from which they were backed up. This option is
the default.

Restore everything to
its original location

Select to restore to a different location, then enter the location to which you want to redirect
the files and directories.

Restore everything to
a different location

Enter the path to restore to. This field is enabled when Restore everything to a different
location is selected.

Destination

This option is available on the Windows interface.

Browse is enabled when Restore everything to a different location is selected. Click it to
browse for the destination directory.

NetBackup browses the local machine where the Backup, Archive, and Restore interface is
running. You cannot browse another machine, even if you have chose to redirect a restore
to a different client.

Browse

This option appears on the Windows interface.

Specify a different location for each item. To restore files to different locations, you must mark
files (not directories).

To specify a different location, double-click an item.

Restore individual
folders and files to
different locations

This option appears on the Java interface.

Specify a different location for each item. To restore files to different locations, you must mark
files (not directories).

To specify a different location, select an item and click Change Selected Destinations.

Restore individual
directories and files
to different locations

This option is not available for this agent.Create and restore to
a new virtual hard
disk file
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Table 4-2 Restore options on the General tab (continued)

DescriptionOption

Overwrites existing the files and directories.Overwrite existing
files

This option is available on the Windows interface. It does not apply when you restore Notes
databases.

Restore the file using
a temporary filename

This option is available on the Windows interface. Prevents any existing files and directories
from being overwritten.

Do not restore the file

Lotus Notes tab
The following additional options are available for Notes restore operations.

Table 4-3 Restore options on the Lotus Notes tab

DescriptionOption

The number of seconds to wait for a busy database.Time to wait for the
database to go offline

Restores the database to the current date and time.Recover databases to
current time

Restores a logged database. Also select either Assign new database instance ID or
Assign new database instance ID and replica ID.

For example, selectNo Recoverywhen you want to restore to a temporary location quickly.
No transaction log recovery is performed on the restored database, which lets you get the
version of the database at the backup time.

No Recovery

Restores a database to a specific date and time.

Select either Assign new database instance ID or Assign new database instance ID
and replica ID. Assign new database instance ID is the default option.

Recover database(s) to
date and time

Creates a new database instance ID, but retains the replica ID. This option is not applicable
when you restore unlogged databases.

Select this option for the following types of restores:

■ Restore of a logged database to an alternate location on same server
■ Point in time restore

Assign new database
instance ID.
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Table 4-3 Restore options on the Lotus Notes tab (continued)

DescriptionOption

Prevents the other databases under replication from writing over the restored database
files. For logged databases, a new database instance ID and a new replica ID are assigned.
For unlogged databases, a new replica ID is assigned.

Select this option to disable replication on restore.

Assign new database
instance ID and replica
ID.

Retains the original IDs for the database. This option is available when you restore a
database to the current time.

Retain original IDs

Wait for Domino server resources to become available before NetBackup starts the restore
process.

Wait until resources are
available

The absolute path for the notes.ini file. The server partition you specify during restore
affects how a database is restored (if logged). It also affects which set of transaction logs
are used for recovery.

To restore a Domino partition server, indicate the file that is associated with the particular
server partition you want to perform the restore.

(UNIX or Linux) To restore a one of multiple Domino server installations, indicate the file
that is associated with the server installation you want to perform the restore.

Specify the absolute
path for the NOTES.INI
file for the server
instance

This option is available on the Java interface. To restore one of multiple Domino server
installations on a server, specify the directory where the Notes program files are installed.

Specify the directory
where Notes is installed

Restoring linked databases or directories and the link file
The following procedure describes how to restore linked databases or directories
and the link file.

Warning: Failure to move the actual database before you restore the link file can
lead to data loss. If you only restore the link, Domino deletes the database that the
link references.

To restore a linked database or directory and the link file

1 Restore the database file to the directory that is referenced in the database or
the directory link.

2 Move the databases that the link file references to a temporary location.

3 Restore the database link file.

4 Move the actual databases back to their original location.

5 On the NetBackup client, open the Backup, Archive, and Restore interface.
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See “Restoring linked databases or directories andmanually recreating the link file”
on page 39.

Restoring linked databases or directories and manually recreating
the link file

The following procedure describes how to restore linked databases or directories
and manually recreating the link file.

Warning: Do not restore the link file.

To restore a linked database or directory

1 Restore the database file to the directory that is referenced in the database or
the directory link.

2 Once the restore is complete, manually recreate the link file in the Domino data
directory.

See “Restoring linked databases or directories and the link file” on page 38.

Redirecting a Notes restore to a different client
A restore redirected to a different client is performed like a regular restore except
that a different destination client is selected. Optionally, a different source client
can also be selected.

To redirect a Notes restore to a different client

1 On the NetBackup client, open the Backup, Archive, and Restore interface.

2 (Windows) Open a Restore window.

(UNIX or Linux) Click the Restore Files tab.

3 (Windows) SelectActions > Specify NetBackupMachines and Policy Type.

(UNIX or Linux) Select File > Specify NetBackupMachines and Policy Type.

4 From the Source client for restores list, select the client.

The source client is the computer name whose backup images you want to
browse.

5 From the Policy type for restores list, select Lotus-Notes.
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6 From the Destination client for restores list, select the client to which to
redirect the restore.

The NetBackup for Domino agent must be installed on the destination client.

7 Click OK.

NetBackup browses for Notes backup images.

Recovering the Notes environment
If you need to recreate the Notes environment, restore both Notes databases and
regular files from backup.

To recover the Notes environment

1 Reinstall the Domino server software.

2 Restore the Domino configuration files (*.id) from the file system backup
image.

Restore these files to the path of the current Domino server installation.

3 Configure the Domino server.

The *.id files that were restored in the previous step can be used to configure
the Domino server for the first time.

4 If the previous Notes environment had transaction logging enabled:

■ Enable transaction logging on the newDomino server, by using the Domino
Administrator application.

■ Restart the Domino server to create new transaction logs.

5 Shut down the Domino server.

6 Make the following change in the notes.ini file.

TRANSLOG_Status=0

7 Add the following line to the notes.ini file:

TRANSLOG_mediaonly=1

8 Move or delete any files that may exist in the translog_path directory.

For example, nlogctrl.lfh or any transaction log extents.
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9 Copy the transaction log extents from the previous Domino server installation
into the current transaction log directory.

Or, you can restore the transaction log extents by using the Backup, Archive,
and Restore interface. The transaction log extents should have a timestamp
later than the timestamp of the backup image from which the databases are
restored.

10 Make the following changes to the notes.ini file:

TRANSLOG_Status=1

TRANSLOG_MediaOnly=1

TRANSLOG_Style=1

11 Start the Domino server to create the new control file of the restored transaction
log extents.

12 Shut down domino server.

13 Use the Backup, Archive, and Restore interface to restore the Notes databases
or mailboxes from the Notes backup image, as follows:

■ If transaction logging is enabled, select the point-in-time to which you want
to recover the databases.

■ If point-in-time is not selected, the database rolls forward to the most recent
available version.

14 After the recovery of the Notes databases is complete, make the following
change to the notes.ini file.

TRANSLOG_MediaOnly=0

(Or, remove the setting from notes.ini.)

15 Start the Domino server.

If backup images of non-Notes databases are not available, you can configure
the newly installed Domino server by creating new *.id files.
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Domino clustering
This chapter includes the following topics:

■ About Domino clustering components

■ Backing up a Domino replicated or clustered environment

■ About the restore and recovery in a Domino replicated or clustered environment

About Domino clustering components
Several components work together to control a Domino cluster. These components
include the Cluster Manager, the Cluster Database Directory, the Cluster Database
Directory Manager, and the Cluster Replicator.

The Cluster Manager runs on each server in a Domino cluster and monitors the
state of the other servers in the Domino cluster.

The Cluster Manager performs the following tasks:

■ Determines which servers belong to the Domino cluster

■ Monitors for server availability and workload

■ Fails over database requests due to unavailability of a clustered Domino server

■ Performs workload balancing

The Cluster Database Directory (CLDBDIR.NSF) is replicated on every server in a
Domino cluster. The Cluster Database Directory contains information for each
database on each server in the Domino cluster. This information includes file name,
server, replica ID, cluster replication status, and out-of-service information. The
different cluster components use this information to perform their tasks.

The Cluster Database Directory Manager (CLDBDIR) task on each server manages
the Cluster Database Directory and keeps it up to date. The Cluster Database
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Directory Manager also monitors the status of each database to determine if they
are out of service or not yet deleted.

The Cluster Replicator (CLREPL) task constantly synchronizes the database replicas
in a Domino cluster. Changes to the database are pushed immediately to the other
replicas in the cluster. This event-drive replication ensures that each time a database
is accessed that it contains the most up-to-date data. The Cluster Replicator task
pushes changes only to those servers in a Domino cluster. The traditional scheduled
replication is used to replicate changes to and from servers outside a Domino
cluster.

Because Domino stores replication events in memory only, both the source server
and destination server must be available for the replication to complete successfully.
If a destination server is not available, the replication events are stored on the
source server until the destination server becomes available. If the source server
shuts down before the replication completes, the replication events in memory are
lost. To prevent this loss, configure immediate replication with all members of the
Domino cluster whenever a Domino cluster server is restarted. Perform scheduled
replications between Domino clustered servers on a regular basis to help maintain
database consistency for all members of the Domino cluster.

Backing up a Domino replicated or clustered
environment

If you use transaction logging, configure your Domino cluster environment as follows:

■ Enable archive-style logging on the server that functions as your backup server.

■ Enable circular-style or linear-style logging on all other servers in the Domino
cluster.
By running circular-style or linear-style logging on the non-backup servers, you
have all the advantages of transaction logging. These advantages include data
reliability and integrity. Also, improved performance can be attained without
having to manage (re-use) the archival-style transaction logs.

■ Back up the Domino files that are not part of the database as part of a standard
backup.
These files include the notes.ini, user certificates IDs, server certificates IDs,
and the cluster.ncf.
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About the restore and recovery in a Domino
replicated or clustered environment

Domino clustering is a “software” clustering solution that relies on software replication
to provide consistency of the databases across all members of the cluster. To
achieve the result you want, knowledge of how replication functions is vital.

See “Example of clustered environment with three Domino servers” on page 45.

See “Example of clustered environment with four Domino servers” on page 44.

See “Backing up a Domino replicated or clustered environment” on page 43.

See “About Domino clustering components” on page 42.

See “About Domino partitioned servers” on page 47.

Example of clustered environment with four Domino servers
The environment is a Domino clustered environment with four Domino servers as
members of the Domino cluster. Server A is identified as your backup server and
runs archive-style transaction logging. Servers B, C, and D run circular or linear-style
logging. To provide load balancing across all the servers, replicas of all databases
exist on all four servers in your Domino cluster. A successful full backup of all
databases was completed earlier in the week. Successful incremental backups of
the archival-style transaction logs are completed every four hours, with the last one
completing two hours ago. At 2:30 P.M., a user complains that the database
acme.nsf is corrupted, while they modified the database on server C over the last
30 minutes. Unfortunately, because the environment is a Domino cluster
environment, the corruption is replicated to all four member servers. The users
state that the database was in a consistent state when they began to modify the
database.

To restore a database to a consistent state do the following:

■ On server A, perform a point-in-time recovery of the database acme.nsf. Select
the database acme.nsf from the last successful backup of the database (for
example, a full backup that was completed successfully earlier in the week).
Begin the restore.

■ On the Lotus Notes tab of the Restore Marked Files dialog box, select the
Assign new database instance ID and replica ID option. Select the Recover
database(s) to specified point in time option. Specify today’s date at 2:00
P.M. (the time that the user started to modify the database) as the point-in-time
for recovery.
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■ After the restore or recovery is successful, a version of acme.nsf from 2:00 P.M.
today should exist on server. Verify the consistency of acme.nsf on server A.
If all is as expected, from server A create new replicas of acme.nsf on servers
B, C, and D. Cluster replication should now be functional on servers A, B, C,
and D, with a consistent version of acme.nsf.

Example of clustered environment with three Domino servers
The environment is a Domino clustered environment with three Domino servers as
members of the Domino cluster. Server C is identified as your backup server and
is running archive-style transaction logging. Servers A and B are running
circular-style or linear-style logging. To provide high availability and load balancing
of mail, replicas exist on several servers. Databases A-L exist on servers A and C.
Databases M-Z exist on servers B and C. A successful full backup of all databases
was completed earlier in the week. Successful incremental backups of the
archive-style transaction logs are completed every four hours, with the last one
completing two hours ago. Today a user discovers that 30 mail messages were
accidentally deleted. They were deleted yesterday at about 3:30 P.M. and were
stored in the database mander.nsf.

To recover accidentally deleted mail messages do the following:

■ On server C, perform a point-in-time recovery of the following database:
UNIX or Linux: /mail/mander.nsf
Windows: mail\mander.nsf
Select the database from the last successful backup of the database (for
example, the full backup that was completed successfully earlier in the week).
Begin the restore.

■ On the Lotus Notes tab of the Restore Marked Files dialog box, select the
Assign new database instance ID and replica ID option. Select the Recover
database(s) to specified point in time option. Specify yesterday’s date at 3:25
P.M. (the time right before the user deleted the mail messages) as the
point-in-time for recovery.

■ A version of the database is recovered to yesterday at 3:25 P.M. and a database
that contains the deleted messages should exist on server C. Verify the existence
of messages in the mander.nsf database on server C. If all is as expected, copy
the accidentally deletedmessages from the database on server C to the database
on server B.

■ After the copy, verify the existence of the messages in the database on server
B. If all is as expected, from server B create a new replica of the following
database on server C.
Windows: mail\mander.nsf
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UNIX and Linux: /mail/mander.nsf
Cluster replication should now be functional for the database on servers B and
C.
In this example the Assign new database instance ID and replica ID option
is chosen. If theAssign new database instance ID option was chosen instead,
the final results of the recovery would be different. The restored database would
function the same, except that the replica ID would not be changed. The database
would be recovered to the specified point-in-time. However, because the replica
ID was not changed during the restore, it would match the replica ID on server
B. Therefore, all the changes to the database between the point-in-time to which
the database was recovered and the current time (including the deletion of the
30 mail messages) eventually is replicated to the database on server C. Two
identical copies of the database exist, one on server B and the other on server
C. Both copies are the same as when the restore was started on server C.
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Domino partitioned servers
This chapter includes the following topics:

■ About Domino partitioned servers

■ About performing backups in a Domino partitioned server environment

■ About restoring a Domino partitioned server environment

About Domino partitioned servers
Domino partitioned servers allow multiple Domino servers to run on a single
computer. The advantages of using Domino partitioned servers are to reduce
hardware expenses and minimize the number of computers to administer. Each
Domino partitioned server has its own Domino data directory and notes.ini file. All
partitioned servers on a single computer share the same Domino program directory.

Use different user accounts for each partitioned server. With different users accounts,
you can easily use commands such as nsd to clean up orphaned processes after
a server crash. The database agent easily supports backups and restores of multiple
server partitions with each using a different user account. It is possible to backup
multiple Lotus partitions from a single NetBackup policy; however, back up each
partition by using a separate data stream.

About performing backups in a Domino
partitioned server environment

The following examples illustrate two possible configurations of the backup selections
list that can be used to back up a Domino partitioned server environment.
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Table 6-1 Backup selections list examples

Backup policyEnvironment

To back up this environment with two separate NetBackup policies, add
the following to the backup selections list:

Policy 1

NOTES_INI_PATH=D:\Lotus\Domino\data1\notes.ini
D:\Lotus\Domino\data1\

Policy 2

NOTES_INI_PATH=D:\Lotus\Domino\data2\notes.ini
D:\Lotus\Domino\data2\

The environment is a Domino partitioned
server environment with two partitions.

The Domino data directory for partition 1 is
located at D:\Lotus\Domino\data1. The
Domino data directory for partition 2 is
located at D:\Lotus\Domino\data2.

To back up this environment with two separate NetBackup policies, add
the following to the backup selections list:

Policy 1

NOTES_INI_PATH=/db/notesdata1/notes.ini
/db/notesdata1

Policy 2

NOTES_INI_PATH=/db/notesdata2/notes.ini
/db/notesdata2

The environment is a Domino partitioned
server environment with two partitions.

The Domino data directory for partition 1 is
located at /db/notesdata1. The Domino
data directory for partition 2 is located at
/db/notesdata2.

Each partition is configured to use archive-style transaction logging. To
back up this environment with a single NetBackup policy, add the
following to the backup selections list:

NEW_STREAM
NOTES_INI_PATH=D:\Lotus\Domino\data1\notes.ini
D:\Lotus\Domino\data1
BACKUP_TRANSACTION_LOGS
NEW_STREAM
NOTES_INI_PATH=D:\Lotus\Domino\data2\notes.ini
D:\Lotus\Domino\data2
BACKUP_TRANSACTION_LOGS
NEW_STREAM
NOTES_INI_PATH=D:\Lotus\Domino\data3\notes.ini
D:\Lotus\Domino\data3
BACKUP_TRANSACTION_LOGS

The environment is a Domino partitioned
server environment with three partitions.

The Domino data directory for each partition
is located as follows:

■ Partition 1, D:\Lotus\Domino\data1
■ Partition 2, D:\Lotus\Domino\data2
■ Partition 3, D:\Lotus\Domino\data3
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Table 6-1 Backup selections list examples (continued)

Backup policyEnvironment

Each partition is configured to use archive-style transaction logging. To
back up this environment with a single NetBackup policy, add the
following to the backup selections list:

NEW_STREAM
NOTES_INI_PATH=/db/notesdata1/notes.ini
db/notesdata1
BACKUP_TRANSACTION_LOGS
NEW_STREAM
NOTES_INI_PATH=/db/notesdata2/notes.ini
BACKUP_TRANSACTION_LOGS
NEW_STREAM
NOTES_INI_PATH=/db/notesdata3/notes.ini
db/notesdata3
BACKUP_TRANSACTION_LOGS

The environment is a Domino partitioned
server environment with three partitions.

The Domino data directory for each partition
is located as follows:

■ Partition 1, /db/notesdata1
■ Partition 2, /db/notesdata2
■ Partition 3, /db/notesdata3

About restoring a Domino partitioned server
environment

The user who owns the partition’s Domino data directory must restore the partitioned
server. For Domino server, the notes.ini file determines how a database to be
restored is accessed and which Lotus transaction log extents to use for recovery.
Because each partition in a partitioned server environment has its own notes.ini,
restore databases from different partitions in separate restore operations.

See “Recovering the Notes environment” on page 40.
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Domino server multiple
installations (UNIX or
Linux)

This chapter includes the following topics:

■ About Domino server multiple installations

■ About configuring NetBackup for a multiple Domino server environment

■ About backups in a multiple Domino server environment

■ About restores a multiple Domino server environment

About Domino server multiple installations
Multiple Domino server installations of same or different versions allow multiple
Domino servers to run on a single computer. These versions can be standalone or
partitioned or a combination of both. The advantages of using Domino partitioned
servers are to reduce hardware expenses and minimize the number of computers
to administer. Each Domino server installation has its own Domino data directory
and notes.ini file.

The NetBackup for Domino agent uses different UNIX user account for each
installation. When you use different accounts it is easier to use commands such as
nsd to clean up orphaned processes after a Domino server crash. To accommodate
this recommendation, It is possible to back up multiple Domino installations from a
single NetBackup policy. However, each installation must be backed up by using
a separate data stream.
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About configuring NetBackup for a multiple
Domino server environment

Run the following script to configure the NetBackup to support backups and restores
of a multiple Domino server environment.

Run the following script from NetBackup's bin directory:

$./lotusnotes_config

Enter the Lotus install path for each Domino installation. For example:

/opt/lotus655/lotus

About backups in a multiple Domino server
environment

The following examples illustrate possible configurations of the backup selections
list when used to back up a Lotus multiple server installation environment.

Table 7-1 Multiple Domino server examples

NetBackup policyEnvironment

To back up this environment with two separate NetBackup policies, add
the following to the backup selections list:

Policy 1

NOTES_INI_PATH=/db/notesdata1/notes.ini
NOTES_INSTALL_PATH=/opt/lotus75/lotus
/db/notesdata1

Policy 2

NOTES_INI_PATH=/db/notesdata2/notes.ini
NOTES_INSTALL_PATH=/opt/lotus76/lotus
/db/notesdata2

The environment is a multiple Domino server
installation environment that runs with two
installations.

For example: installation 1 of 7.5 version
and installation 2 of 7.6 version are installed
at /opt/lotus75/lotus and
/opt/lotus76/lotus respectively. The
Domino data directory for installation 1 is
located at /db/notesdata1 and the
Domino data directory for installation 2 is
located at /db/notesdata2.
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Table 7-1 Multiple Domino server examples (continued)

NetBackup policyEnvironment

To back up this environment with a single NetBackup policy, add following
to the backup selections list:

Policy 1

NEW_STREAM
NOTES_INI_PATH=/db/notesdata1/notes.ini
NOTES_INSTALL_PATH=/opt/lotus71/lotus
/db/notesdata1
BACKUP_TRANSACTION_LOGS
NEW_STREAM
NOTES_INI_PATH=/db/notesdata2/notes.ini
NOTES_INSTALL_PATH=/opt/lotus75/lotus
/db/notesdata2
BACKUP_TRANSACTION_LOGS
NEW_STREAM
NOTES_INI_PATH=/db/notesdata3/notes.ini
NOTES_INSTALL_PATH=/opt/lotus76/lotus
/db/notesdata3
BACKUP_TRANSACTION_LOGS

The environment is a multiple Domino server
installation environment that runs with three
installations.

For example: installation 1 of 7.1 version,
installation 2 of 7.5 version, and installation
3 of 7.6 version are installed at
/opt/lotus71/lotus,
/opt/lotus75/lotus and
/opt/lotus76/lotus, respectively. The
Domino data directory for installation 1 is
located at /db/notesdata1, the Domino
data directory for installation 2 is located at
/db/notesdata2, and the Domino data
directory for installation 3 is located at
/db/notesdata3. Each installation is
configured to use archive style transaction
logging.

About restores a multiple Domino server
environment

As with restores of a standalone Domino server environment, the user owns the
Domino data directory for the installation that must restore the server installation.
For Domino server, the notes.ini file determines how a database to be restored is
accessed and which transaction log extents to use for recovery. Because each
Domino server installation has its own notes.ini, databases from different
installations must be restored in separate restore operations.
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Troubleshooting
NetBackup for Domino

This chapter includes the following topics:

■ About NetBackup for Domino debug logging

■ About NetBackup status reports

■ About Notes restore operations

■ Windows client backup fails with status 69

■ Point-in-time restore from master server fails with status 12

About NetBackup for Domino debug logging
The NetBackup master server and client software offers a comprehensive set of
debug logs for troubleshooting problems that can occur during NetBackup
operations. Debug logging is also available for Domino server backup and restore
operations.

See the following topics for information on how to create the logs and how to control
the amount of information written to the logs.

See “” on page 54.

See “Debug logs for NetBackup for Domino backup operations” on page 54.

See “Debug logs for NetBackup for Domino restore operations” on page 54.

See “Setting the debug level on a NetBackup for Domino Windows client”
on page 55.

See “Setting the debug level on a UNIX client” on page 54.
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After you determine the cause of the problem, disable debug logging by removing
the previously created debug logging directories. Details are available on the
contents of these debug logs.

See the NetBackup Logging Reference Guide.

Additional information about NetBackup client logs and NetBackup master server
logs is available.

See the online help for the Backup, Archive, and Restore interface.

See the NetBackup Administrator’s Guide, Volume I.

Note:When debug logging is enabled, the files can become large. The same files
are used by normal file backups.

You can enable debug logging by running a batch file that creates each log directory.
To create all log file directories automatically, run the following:

install_path\NetBackup\logs\mklogdir.bat

Debug logs for NetBackup for Domino backup operations
To turn on debug logging for standard backup operations, create the following:

(Windows) install_path\NetBackup\logs\bpbkar

(UNIX or Linux) /usr/openv/netbackup/logs/bpbkar

Debug logs for NetBackup for Domino restore operations
To turn on debug logging for restore operations, create the following directory:

install_path\NetBackup\logs\tar

/usr/openv/netbackup/logs/tar

For all restores, tar logs exist on the primary client.

Setting the debug level on a UNIX client
The debug logs are located in /usr/openv/netbackup/logs.
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To set the debug level on a UNIX client

◆ Enter the following line in the bp.conf file.

VERBOSE = X

Where X is the debug level you want.

Setting the debug level on a NetBackup for Domino Windows client
To control the amount of information that is written to the debug logs, change the
“General” debug level. Typically, the default value of 0 is sufficient. However,
technical support may ask you to set the value higher to analyze a problem.

The debug logs are located in install_path\NetBackup\logs.

To set the debug level for the legacy process on a NetBackup for Domino
client

1 Open the Backup, Archive, and Restore program

2 Select File > NetBackup Client Properties.

3 Click the Troubleshooting tab.

4 Set the General debug level.

5 Click OK to save your changes.

To set the debug level for the processes that use unified logging on a
NetBackup for Domino client

1 Newer NetBackup processes such as ncfgre use Veritas Unified Logging
(VxUL). To increase VxUL logging level, run the following:

install dir\NetBackup\bin\vxlogcfg -a -p 51216 -o OID -s

DebugLevel=6 -s DiagnosticLevel=6

For a list of all OID values, see the NetBackup Logging Reference Guide.

2 To reset the VxUL logging level default value, run the following command:

install dir\NetBackup\bin\vxlogcfg -a -p 51216 -o OID -s

DebugLevel=1 -s DiagnosticLevel=1

About NetBackup status reports
NetBackup provides many standard status reports to verify the completion of backup
and restore operations. In addition, users and the administrator can set up additional
reports if a site requires them.
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The administrator has access to operational progress reports through the NetBackup
Administration Console. Reports can be generated for Status of Backups, Client
Backups, Problems, All Log Entries, Media Lists, Media Contents, Images onMedia,
Media Logs, Media Summary, and Media Written. These reports can be generated
for a specific time frame, client, or master server.

See the NetBackup Administrator’s Guide, Volume I for details.

Progress reports on the client allow easy monitoring of user operations. When
reports are created by the NetBackup client for each user-directed backup or restore
operation, administrators can monitor these operations and detect any problems
that may occur.

Viewing the progress report of a NetBackup for Domino operation
This topic describes how to view the progress report of a NetBackup for Domino
backup or restore operation.

To view the progress report of a NetBackup for Domino operation

1 Click the Task Progress tab.

2 Click Update Task List.

3 Choose File > View Status.

4 Click the task for which you want to check the progress.

5 Click Refresh.

More information is available on progress reports and the meaning of the
messages.

See the NetBackup Backup, Archive, and Restore Getting Started Guide.

About Notes restore operations
The following operations are performed during a database restore:

■ The database is taken offline.

■ The database (file data) is restored.

■ The Notes change information is applied.
If recovery of logged databases is requested, it is done after all logged and all
unlogged databases are restored.

■ The database is recovered (transactions from transaction logs are applied).

■ The database is brought online.
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Once the restore is complete, NetBackup attempts to recover all logged databases
that were restored. The logged databases that were restored are rolled forward to
a specific point in time by using the appropriate transactions from the required
transaction logs. Then the databases are brought back online. Any required
transaction logs are restored automatically as part of the recovery operation if they
were previously backed up and recycled. Do not restore transaction log extents
manually.

Windows client backup fails with status 69
If the ALL_LOTUS_DATABASES directive is encountered during a backup of a
Notes Windows client, the backup fails with a status 69: The file list string

is invalid. For Windows clients, create a backup selections list that includes the
directories that contain the actual Notes databases. If you have both UNIX and
Windows clients, create at least two policies: one exclusively for UNIX clients and
another exclusively for Windows clients.

Point-in-time restore frommaster server fails with
status 12

The restore jobs that use point-in-time are initiated from the master server can fail
with a status 12. Specifically, the automatic restore of Notes transaction log extents
during recovery of the Notes database can fail. This failure occurs if the install path
of the master server is different from the install path of the NetBackup client.

See the NetBackup Troubleshooting Guide for more information.
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